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1. Related Manuals 
 
To ensure system safety, make sure to always read and follow the information provided in all 
Safety Precautions and Precautions for Safe Use in the manuals for each device which is 
used in the system. 
The following OMRON Corporation (hereinafter referred to as “OMRON”) manuals are related 
to this document: 
 

Cat. No. Model Manual name 
W500 NJ Series NJ-series CPU Unit Hardware User’s Manual 
W501 NJ/NX Series NJ/NX-series CPU Unit Software User’s Manual 
W506 NJ/NX Series NJ/NX-series CPU Unit Built-in EtherNet/IP Port 

User’s Manual 
W504 SYSMAC-SE2□□□ Sysmac Studio Version 1 Operation Manual 
W502 NJ/NX Series Machine Automation Controller Instructions 

Reference Manual 
Z432 V320-F/V330-F/V420-F/V430-F 

Series 
MicroHAWK V320-F/V330-F/V420-F/V430-F 
Series Barcode Reader User Manual 

Z407 V320-F/V330-F/V420-F/V430-F 
Series 

Autofocus Multicode Reader MicroHAWK 
V320-F/V330-F/V420-F/V430-F Series User 
Manual for Communication Settings 
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2. Terms and Definitions 
 
Below is a list of terms used in this manual and their definitions. 
 

Term Description/Definition 
Node It refers to a relay point, a branch point or a terminal on an EtherNet/IP 

network comprised of equipment having an EtherNet/IP port. Devices 
with one EtherNet/IP port are recognized as one node on the 
EtherNet/IP network, and devices with two EtherNet/IP ports are 
recognized as two nodes. 

Tag A tag is a unit that is used to exchange data with tag data links. Data is 
exchanged between the local network variables and remote network 
variables specified in the tags or between specified I/O memory areas. 

Tag Set When a tag data link connection is established, one or more tags (up to 
eight tags including the controller status) are configured as a set. This is 
referred to as a Tag Set. Each tag set represents the unit of data that is 
linked for a tag data link connection. Tag data links are therefore created 
through a connection between one tag set and another tag set. A tag set 
name must be set for each tag set. 

Tag Data Link The Implicit communications of the EtherNet/IP standard is called a Tag 
Data Link. Tag data links enable cyclic tag data exchange between 
controllers or between a controller and other devices on an EtherNet/IP 
network. 

Connection A connection is used to exchange data as a unit within which data 
concurrency is maintained. 

Connection Type 
 
 

You can select multi-cast or unicast (point-to-point) as the connection 
type in the tag data link connection settings. Multi-cast sends an output 
tag set in one packet to more than one node. Unicast, on the other hand, 
individually sends one output tag set to each node. Therefore, using a 
multi-cast connection can decrease the communications load when 
sending one output tag to multiple nodes. 

Originator and 
Target 

To use tag data links, it is necessary to first establish a connection 
between the nodes that use them. The node that requests a connection 
is called the originator, and the node that receives the request is called 
the target. 

Tag Data Link 
Parameters 

In tag data link setting, “tag settings”, “tag set settings” and “connection 
settings” are collectively called “tag data link parameters”. 

EDS File It is a file describing device-specific information such as the number of 
input/output points for EtherNet/IP devices. 
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3. Restrictions and Precautions 
 
(1) Before building a system, understand the specifications of devices which are used in the 

system. Allow some margin for ratings and performance, and provide safety measures 
such as installing a safety circuit in order to minimize the risk in case of failure. 

(2) To ensure system safety, make sure to read and follow the information provided in all 
Safety Precautions and Precautions for Safe Use in the manuals for each device which is 
used in the system. 

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to. 

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this 
document without the permission of OMRON Corporation. 

(5) The information contained in this document is current as of February 2023.  
It is subject to change for improvement without notice. 

 
The following notations are used in this document. 
 

 

Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or may result in serious 
injury or death. Additionally, there may be severe property 
damage. 

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or property damage. 

 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure proper operation and performance. 

 

 Note 
Additional information to read as required. 
This information is provided to increase understanding or make operation easier. 

 
Symbols 

 

The filled circle symbol indicates operations that 
you must do. 
The specific operation is shown in the circle and 
explained in text. 
This example shows a general precaution for 
something that you must do. 
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4. Overview 
 
This document describes the procedures for connecting the OMRON code reader products 
(V330-F/V430-F Series) to an NJ Series Machine Automation Controller (hereinafter referred 
to as the controller) via EtherNet/IP and for checking their connections. 
Refer to Section 6. EtherNet/IP Settings and Section 7. EtherNet/IP Connection Procedure to 
understand setting methods and key points to operate EtherNet/IP tag data links. 
 

 Note 
The settings described in 7.3. Controller Setup are already made in advance in the Sysmac 
Studio project file (hereinafter referred to as “project file”) listed below. For how to use this 
project file, refer to 9. Appendices How to Use the Project File. Obtain the latest version of the 
project file from OMRON Corporation. 

Name Filename Version 
Sysmac Studio Compact Project 
File (Extension: csm2) 

OMRON_V330_EIP_V100.csm2 Ver. 1.00 

Sysmac Studio Compact Project 
File (Extension: csm2) 

OMRON_V430_EIP_V101.csm2 Ver. 1.01 
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices that can be connected are as follows: 
 

Manufacturer Name Model Version 
OMRON NJ Series CPU Unit NJ501-1500 

NJ501-1400 
NJ501-1300 
NJ301-□□□□ 

Same or 
later 
version as 
indicated in 
section 5.2. OMRON Code reader V330-F□□□□□□□-□□□ 

V430-F□□□□□□□-□□□ 
 

 

 Note 
This document describes the procedures for establishing the network connections. It does 
not provide information on operation, installation, and wiring methods that are not directly 
related to the connection procedures. It also does not describe the function or operation of 
the equipment. Please refer to the instruction manual or contact the equipment manufacturer. 

 

 Note 
From among the above applicable devices, this document uses the devices listed in section 
5.2 for the connection check. When using devices that are not described in section 5.2, check 
the connection according to this document. 

 

 Precautions for Correct Use 

The connection and connection check procedures described in this document use the 
devices listed in section 5.2, from among the above applicable devices. 
You cannot use devices with versions earlier than the versions listed in section 5.2. 
To use models that are not listed in section 5.2. or versions that are later than those listed in 
section 5.2., check the differences in the specifications according to their instruction manuals 
before operating the devices. 
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5.2. Device Configuration 
The system components required for reproducing the connection procedures described in this 
document are as follows. 
 

• Configuration with V330-F 
 
 
 
 
 
 
 
 

 
 

Manufacturer Name Model Version 
OMRON NJ Series CPU Unit  

(Built-in EtherNet/IP Port) 
NJ301-1200 Ver. 1.19 

OMRON Power Supply Unit NJ-PA3001  
OMRON Switching hub W4S1-05C  
OMRON Sysmac Studio SYSMAC-SE2□□□ Ver. 1.44 
OMRON Sysmac Studio Project File OMRON_V330_EIP_V100

.csm2 
Ver. 1.00 

--- PC (OS: Windows 10) ---  
--- USB cable 

(USB 2.0-compliant B-type 
connector) 

---  

--- LAN cable (STP (shielded, 
twisted-pair) cable of Ethernet 
category 5 or higher) 

  

OMRON Code reader V330-F064N12M-NNX Ver. 2.1.0 
OMRON PoE (Power over Ethernet) injector Select one that can be 

powered via Ethernet. 

--- 

--- 24 VDC power supply ---  
 
 

  

USB cable LAN cable 
 
 

PC 
(Windows 10,  
with Sysmac  
Studio installed) 

LAN cable 

NJ301-1200 
(Built-in EtherNet/IP Port) Switching hub 

W4S1-05C 

24 VDC power supply 

V330-F064N12M-NNX 

LAN cable 
 
 
 

PoE injector 
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• Configuration with V430-F 
 
 
 
 
 
 
 
 

 
 

Manufacturer Name Model Version 
OMRON NJ Series CPU Unit  

(Built-in EtherNet/IP Port) 
NJ301-1200 Ver. 1.19 

OMRON Power Supply Unit NJ-PA3001  
OMRON Switching hub W4S1-05C  
OMRON Sysmac Studio SYSMAC-SE2□□□ Ver. 1.44 
OMRON Sysmac Studio Project File OMRON_V430_EIP_V101

.csm2 
Ver. 1.00 

--- PC (OS: Windows 10) ---  
--- USB cable 

(USB 2.0-compliant B-type 
connector) 

---  

--- LAN cable (STP (shielded, 
twisted-pair) cable of Ethernet 
category 5 or higher) 

---  

OMRON Code reader V430-F000M12M-SRX Ver. 2.1.0 
OMRON I/O Cable V430-W8-3M  
OMRON Ethernet cable V430-WE-3M  
--- 24 VDC power supply ---  

 
  

I/O Cable 
V430-W8-3M 

V430-F000M12M-SRX 

24 VDC power supply 24 VDC power supply 

USB cable 
LAN cable 

NJ301-1200 
(Built-in EtherNet/IP Port) Switching hub 

W4S1-05C 
PC 
(Windows 10,  
with Sysmac  
Studio installed) 
 

Ethernet cable 
V430-WE-3M 
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 Precautions for Correct Use 

Ensure that the Sysmac Studio is updated to the version specified in this documentation, or 
to a higher version. 
If you use a version other than the version specified in this section, there may be differences 
in the procedures in Section 7 and later. In that case, refer to the Sysmac Studio Version 1 
Operation Manual (Cat. No. W504) to perform the equivalent procedures. 

 

 Note 
Refer to the Industrial Switching Hub W4S1 Series User Manual (0969584-7) for power 
supply specifications that can be used for 24 VDC power supply (for the switching hub). 

 

 Note 
Refer to the MicroHAWK V320-F/V330-F/V420-F/V430-F Series Barcode Reader User 
Manual (Cat. No. Z432) for the power supply specifications that can be used for 24 VDC 
power supply (for the code reader). 

 

 Note 
This document assumes that the USB is used to connect the controller. For information on 
how to install the USB driver, refer to A-1 Driver Installation for Direct USB Cable Connection 
in Appendices of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504). 
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6. EtherNet/IP Settings 
 
This section shows the specifications of the parameters, global variables, tag sets, and tag 
data link table that you set in this document. 
In subsequent sections, the code reader may also be referred to as “target device” depending 
on the description. 
 

6.1. Parameters 
The parameters that you set in this document are shown below. 
 

6.1.1. EtherNet/IP Communication Settings 
The parameters used for connecting the controller and the code reader via EtherNet/IP are as 
follows. 

 
* For the use cases in this document, setting the gateway is unnecessary because the devices 

are connected within the same segment of the network.  
Set the code reader’s gateway setting to any value. It must not be left blank. 

 
6.1.2. About the Code Reader Assemblies 

The code reader has six types of Input Assemblies and two types of Output Assemblies, and 
one type can be selected for each. 
The data structure changes based on the selected assembly. 

 

For a detailed explanation of memory allocation and the data structure of each assembly, refer 
to Appendices A-2 EtherNet/IP Specifications in the Autofocus Multicode Reader MicroHAWK 
V320-F/V330-F/V420-F/V430-F Series User Manual for Communication Settings (Cat. No. 
Z407). 

Parameter name Controller Code reader 
Ethernet --- Enabled 
IP address 192.168.188.200 192.168.188.2 
Subnet mask 255.255.0.0 255.255.0.0 (default) 
Gateway --- 0.0.0.0 (default), any value 
IP Address Mode --- Fixed 
EtherNet/IP --- Enabled 
KeepAlive Enabled (default) --- 

 

Assembly Type Assembly Name Assembly Number 
Input Assembly Small Input Assembly 100 
Input Assembly Large Input Assembly 101 
Input Assembly MXL/SLC Input Assembly 102 
Input Assembly 1 Decode Input Assembly 103 
Input Assembly 4 Decode Input Assembly 104 
Input Assembly N Decode Input Assembly 105 
Output Assembly Output Assembly 197 
Output Assembly Output Assembly (Legacy) 198 
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6.2. Data Types to Use for Tag Data Links 
This section describes an example of using data types for the code reader’s tag data link data. 
 
<Input and Output Assemblies> 
• Input Assembly: 1 Decode Input Assembly (103) 
• Output Assembly: Output Assembly (197) 
 
 

6.2.1. Output Area 
The Output Area is an area where you can send commands to the code reader, such as 
trigger input commands and commands for registering Match strings. 

 
■ Definition of Output Area access data types (structure) 
Data types for accessing the Output Area. 

 
Name of data type Data type Code reader data 

S_EIPOutput197 STRUCT --- 

 COMMANDS COMMAND Control signal (32 bits) 
 

■ Definition of control signal area access data types (structure) 
Data types for accessing the control signal area. 
 

Name of data type Data type Code reader data 
COMMAND ARRAY[0..31] 

OF BOOL 
--- 

 Run_Mode BOOL Run Mode 
 Trigger BOOL Trigger 
 Enable_MatchCode BOOL Enable MatchCode 
 Omitted 

 Output_2 BOOL Output 2 
 Output_3 BOOL Output 3 
 Reserved ARRAY[0..17] 

OF BOOL 
Reserved for future use 

  
 
6.2.2. Input Area 

The Input Area is an area where you can check the control status and output character strings 
of the code reader, such as Accept Trigger confirmation and Read OK/NG results. 
 

■ Definition of Input Area access data types (structure) 
Data types for accessing the Input Area. 
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Name of data type Data type Code reader data 
S_EIPInput103 STRUCT --- 

 INFO_BITS BYTE INFO BIT 
 RESERVED1 BYTE Reserved for future use 
 RESERVED2 BYTE Reserved for future use 
 RESERVED3 BYTE Reserved for future use 
 DEVICE_STATUS Device_Status Status Signal (32 bits) 
 FAULT CODE DINT Error code 

 
COUNTERS ARRAY[0..5] 

OF DINT 
Read Count Information 

 
READ_CYCLE_ 
REPORT 

ARRAY[0..3] 
OF INT 

Read Cycle Report 

 
DECODE_CYCLE_ 
REPORT 

ARRAY[0..3] 
OF DINT 

Decode Cycle Report 

 DECODE_LENGTH DINT Decoded String Length 

 
DECODE_DATA ARRAY[0..435] 

OF BYTE *1 
Decoded String 

*1. The original data type is defined as "SINT". In this document, it is defined as "BYTE" that can be 

displayed in “ASCII” for readability when monitoring with the Watch Tab Page of Sysmac Studio. 

 
■ Definition of Status Signal area access data types (structure) 
Data types for accessing the Status Signal area. 
 

Name of data type Data type Code reader data 
Device_Status ARRAY[0.31]

OF BOOL 
--- 

 Run_Mode BOOL Run Mode 
 Trigger_Acknowledge BOOL Accept trigger 
 Exposure_Done BOOL Exposure Done 
 Omitted 
 Output3_Status BOOL Output3 Status 
 Buffer_Overflow BOOL Buffer Overflow 
 Reserved ARRAY 

[0..9] OF 
BOOL 

Reserved for future use 

 
 

 Note 
Please refer to Appendices A-2 EtherNet/IP Specifications in the Autofocus Multicode 
Reader MicroHAWK V320-F/V330-F/V420-F/V430-F Series User Manual for Communication 
Settings (Cat. No. Z407) for a description of how to use each bit. 
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6.3. Global Variables 
The controller treats the data in tag data links as global variables. The settings for global 
variables are shown below. 
The global variables below are set in the “project file”. 
 

Variable Network Publish Data type Application 
EIPOutput Out S_EIPOutput197 For data links to the Output Area 

EIPInput In S_EIPInput103 For data links to the Input Area 

 
■ EIPOutput Structure 

Code reader data Variable name Data type 
Control signal (32 bits) EIPOutput.COMMAND*1 BOOL[32] 

 
*1. Control Signal Assignment 

Variable: EIPOutput.COMMAND Assignment 
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

              TRIG RUN_
MODE 

 
31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 

                
 

TRIG: Execute Read Bit: When ON, Read is executed. 
RUN MODE: When ON, Trigger can be accepted and Read Cycle is enabled. 
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■ EIPInput Structure 
Code reader data Variable name Data type 

INFO BIT EIPInput.INFO_BITS BYTE 

Reserved for future use EIPInput. RESERVED1 BYTE 

Reserved for future use  EIPInput. RESERVED2 BYTE 

Reserved for future use EIPInput. RESERVED3 BYTE 

Status Signal (32 bits) EIPInput.Device_status*1 BOOL[32] 

Error code EIPInput. FAULT DINT 

Read Count Information EIPInput. COUNTERS DINT[6] 

Read Cycle Report 
EIPInput. 
READ_CYCLE_REPORT 

INT[4] 

Decode Cycle Report 
EIPInput. 
DECODE_CYCLE_REPORT 

INT[8] 

Decoded String Length EIPInput. DECODE_LENGTH DINT 

Decoded String EIPInput DecodeData BYTE[436] 
 
*1. Control Signal Assignment 

Variable: EIPInput.Device_status Assignment 
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

           DataIs
Ready 

Deco
ding  

Trigger
Acknow
ledge 

Run 
Mode 

 
31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 

                
 
RunMode: ON when in Read Cycle 
Trigger Acknowledge: ON when Output Assembly Trigger Bit is received 
Decoding: ON while image is being processed 
DataIsReady: ON when Data Output and Judgment are verified 
 
 

 

 Note 
The Sysmac Studio has two input methods to specify an array for a data type. If an array is 
specified in (1), it is converted to (2) after input, and the data type is always displayed in (2). 

(1) BOOL[16] and (2) ARRAY[0..15] OF BOOL 
In this document, the data type is described in BOOL[16] for simplicity. 
(The example above means a BOOL data type with sixteen array elements.) 
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6.4. Tag Set 
The settings of a tag set to use tag data links are shown below. 
Set the data in the tag set in ascending order of the OUT No. or IN No. as shown below. 
 
■ Output Area (Controller → Code Reader) 

Originator Variable (Tag set name) Data size (bytes) 
EIPOutput 4 
 OUT No. Global Variable Name (Tag name) Data size (bytes) 
 1 EIPOutput 4 

 
■ Input Area (Controller ← Code Reader) 

Originator Variable (Tag set name) Data size (bytes) 
EIPInput 500 
 IN No. Global Variable Name (Tag name) Data size (bytes) 
 1 EIPInput 500 

 
 

6.5. Tag Data Link Table 
The contents of the tag data link table (connection settings) are shown below. 
The values shown in the red frames are the values defined in the EDS file of the code reader. 
 
Connection 

Name Connection I/O Type RPI (ms) Timeout 

default_001 Input 1 Decode 10.0 RPI x 32 
 

Connection 
I/O Type 

Input/ 
Output 

Target Variable 
 

Size 
(bytes) 

Originator Variable 
(Tag set name) 

Size 
(bytes) 

Connection 
Type 

Input 1 
Decode 

In 103 500 EIPInput 500 
Point to 

Point 
connection 

Out 197 4 EIPOutput 4 
Point to 

Point 
connection 
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7. EtherNet/IP Connection Procedure 
 
This section describes the procedures for connecting the code reader and controller on an 
EtherNet/IP network. 
In this document, it is assumed that the controller and the code reader use the factory default 
settings. For how to initialize the devices, refer to Section 8. Initializing the System. 
 

7.1. Operation Flow 
The procedures for setting up the EtherNet/IP tag data links are as follows. 
 

7.2. Code Reader Setup  Set up the code reader. 
▼   

 7.2.1. Setting the Parameters  Set the parameters for the code reader. 
   

7.3. Controller Setup  Set up the controller. 
▼   

 7.3.1. Setting the IP Address  Start the Sysmac Studio and set the IP address of 
the controller. 

▼   
 7.3.2. Installing the EDS File  Install the EDS file required for EtherNet/IP 

communication with the code reader. 
▼   

 7.3.3. Registering the Target Device  Register the target device. 
▼   

 7.3.4. Setting the Global Variables  Set the global variables to use for the tag data 
links. 

▼   
 7.3.5. Registering the Tags  Register the tags and tag sets. 

▼   
 7.3.6. Setting Up the Connections 

 
Set the target variables and the originator 
variables to add connections, and then set up the 
connections. 

▼   
 7.3.7. Transferring the Project Data 

 
Place the Sysmac Studio online and transfer the 
connection settings and project data to the 
controller. 

   
7.4. Checking the EtherNet/IP 

Communications 
 Check that the EtherNet/IP tag data links are 

operating normally. 
▼   

 7.4.1. Checking the Connection Status  Check the EtherNet/IP connection status. 
▼   

 7.4.2. Checking the Sent and 
Received Data 

 Check that the correct data is sent and received. 
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7.2. Code Reader Setup 
Set up the code reader. 

 
7.2.1. Setting the Parameters 

Set the parameters for the code reader. 
Set the IP address of your PC to 192.168.188.100 and its subnet mask to 255.255.0.0. 
 

1 
 

[Using V330-F] 
 
Connect the cord reader and the 
switching hub to the PoE injector 
with a LAN cable. 
 
 
 

 

[Using V430-F] 
 
Connect the Ethernet connector 
of the code reader to the 
switching hub with the Ethernet 
cable. 
 
Connect the I/O cable to the I/O 
connector and turn ON the 24 
VDC power supply. 
 
* In this document, only the 

power supply wires of the I/O 
cable are connected and 
checked. Be careful not to 
short-circuit any other wires. 

 
* Ground the shield wire as 

needed. For more information 
on grounding, please refer to 
Grounding in Appendices of 
the MicroHAWK 
V320-F/V330-F/V420-F/V430-
F Series Barcode Reader User 
Manual (Cat. No. Z432). 

 

2 Connect the PC to the switching 
hub with a LAN cable. 
 
Connect 24 VDC power supply 
(for the switching hub) to the 
switching hub. 

 
 

 
 

  24 VDC power supply  
 

Switching hub 
W4S1-05C 

LAN cable LAN cable 

V330-F064N12M 
-NNX PoE injector 

Red Striped 

Gray Striped 

24 VDC 
power 
supply 

Switching 
hub 

LAN cable 

I/O Cable 
V430-W8-3M 

Ethernet cable 
V430-WE-3M 

I/O 
Connector 

Ethernet 
Connector 
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3 Set the IP Address of the PC. 
For the IP address, enter 
192.168.188.100. 
For the subnet mask, enter 
255.255.0.0. 
 
For the procedure to open the 
screen on the right, please refer 
to step 4. 

 

 
 

4 Static connection (Setting the fixed IP address) 
(1) From the Windows Start Menu, select Control Panel – Network and Internet – Network 
and Sharing Center. 
(2) Click on Local Area Connection. The Local Area Connection Status Dialog Box is 
displayed. Click Properties. 
(3) In the Local Area Connection Properties Dialog Box, select Internet Protocol Version 4 
(TCP / IPv4), and click the Properties Button. Set the IP Address of the PC to 
192.168.188.100. 
(4) Click the OK Button. 
 

5 Start your browser and enter 
http://192.168.188.2. 
“Google Chrome” is the 
recommended browser. 
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6 When the WebLink startup 
screen is displayed, go to step 
8. 
 
If the WebLink startup screen 
does not appear, go to step 7. 

 

 

 

7 If the WebLink startup screen does not appear, it means that communications are not 
established between the code reader and the PC. Please check the following. 
 
• Does the code reader and the PC have a proper physical (cable) connection? 
• Are the IP Addresses of the PC and code reader set correctly? 

→ Refer to step 4 for setting the IP address of the PC. 
• Do a hardware reset of the code reader. 

→ When turning ON the power supply, press and hold the setup button on the code 
reader body until its light turns on. 

 
For other measures that can be taken, please refer to When unable to access by WebLink in 
Q&A in Appendices of the MicroHAWK V320-F/V330-F/V420-F/V430-F Series Barcode 
Reader User Manual (Cat. No. Z432). 

8 The WebLink screen appears.  

 
 

9 Click on the Setup tab and, in 
Read Cycle Sequence, set 
Cycle to Triggered. 
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10 Click on the gear icon on the 
upper right of the screen to 
select Advanced. 

 

 
 

11 The Advanced Settings Screen 
appears. 
Check the settings shown in the 
red frames. 
EtherNet/IP connection is 
Enabled by default, so you do 
not need to change the settings 
with the default setting. 
 
If you need to change the IP 
address, for example when 
connecting multiple code 
readers, change the IP Address 
setting as necessary. 

 
 

12 Click on the icon shown in the 
red frame to save the settings to 
the code reader. 
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13 Finally, check the version 
number of the code reader. Click 
on the gear icon on the upper 
right of the screen and select 
About WebLink. 

 

14 About WebLink is displayed, so 
you can check the current 
version of the code reader. 
 
Please update the code reader 
to the latest version if 
necessary. 
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7.3. Controller Setup 
Set up the controller. 
 

7.3.1. Setting the IP Address 
Start the Sysmac Studio and set the IP address of the controller. 
Install the Sysmac Studio and USB driver on the PC beforehand. 
 

1 Connect a LAN cable to the 
Built-in EtherNet/IP Port 
(PORT1) and a USB cable to 
the peripheral (USB) port of the 
controller, and connect a PC 
and a switching hub to the 
controller as shown in 5.2. 
Device Configuration. 

 

2 Start the Sysmac Studio. 
 
* If a user account control dialog 

box is displayed at startup, 
select the option to start. 

 

3 Start the Sysmac Studio. 
Click New Project. 

 

USB cable 

CPU Unit End Cover PC 

Power Supply Unit LAN cable 

Switching hub 

Code reader 

Controller 
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4 The Project Properties Screen 
is displayed. 
 
* This document assumes that 

the project name is New 
Project. 

 
Make sure that, in Select 
Device, Category and Device 
are set for the device to use. 
 
Select an applicable version 
from the Version pull-down list. 
 
* Although 1.19 is selected as 

an example in this document, 
select the version you actually 
use. 

 

 

5 Click Create. 
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6 The New Project Window is 
displayed. 
 
This window consists of the 
following panes. 
Left: Multiview Explorer 
Upper right: Toolbox 
Lower right: Controller Status 
Pane 
Top middle: Edit Pane 
In the lower center of the 
window, the tabs for the 
following tab pages are 
displayed. 
Output Tab Page 
Build Tab Page 

 

7 Double-click Built-in 
EtherNet/IP Port Settings 
under Configurations and 
Setup – Controller Setup in the 
Multiview Explorer. 

 

8 The Built-in EtherNet/IP Port 
Settings Tab Page is displayed 
in the Edit Pane. 
In IP Address, set the following 
information. 
IP address: 192.168.188.200 
Subnet mask: 
255.255.0.0 

 
 

Controller 
Status Pane 

Toolbox 

Edit Pane Multiview 
Explorer 

Output Tab 
Page 

Build Tab 
Page 
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7.3.2. Installing the EDS File 
Install the EDS file. 
The EDS file can be downloaded from the OMRON web page. 
Note that, for V430, the required EDS file differs depending on the version. 
 

1 Select EtherNet/IP Connection 
Settings from the Tools Menu. 

 

2 Double-click Built-in 
EtherNet/IP Port Settings. 

 

3 In the Toolbox, right-click on 
Target Device and select 
Display EDS Library. 
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4 The EDS Library Dialog Box is 
displayed. Select Install. 

 

5 Select the EDS file that you 
downloaded and then select 
Open. 
 
Note that there are two EDS 
files, one for V330-F and the 
other for V430-F. 

 

6 Check that the selected EDS file 
for V330-F or V430-F is installed 
in Microscan Systems,Inc. – 
Generic Device. 
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7.3.3. Registering the Target Device 
Register the target device. 
 

1 Select EtherNet/IP Connection 
Settings from the Tools Menu. 

 

2 In the Edit Pane, the 
EtherNet/IP Device List Tab 
Page is displayed. 
Right-click on Built-in 
EtherNet/IP Port Settings and 
select Edit from the menu. 

 

 

3 The Built-in EtherNet/IP Port 
Settings Connection Settings 
Tab Page appears in the Edit 
Pane. 

 

4 Click on + in the Toolbox. 
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5 The target device registration 
dialog box appears. 
 
In Node address, enter 
192.168.188.2. 
In Model name and Revision, 
set the following values by 
clicking on the corresponding 
field and selecting from the 
pull-down menu. 
Model name: V330-F or V430-F 
Revision: 1 or 2 
Here, the model name V430-F, 
revision 2 is selected. 

 

6 Check the settings and click 
Add. 

 

7 192.168.188.2 is registered in 
Target Device in the Toolbox. 

 
 
  



7. EtherNet/IP Connection Procedure 
 

 30 

7.3.4. Setting the Global Variables 
Set the global variables to use for the tag data links. 
An example of using the following assemblies is shown here. 
• Input Assembly: 1 Decode Input Assembly (103) 
• Output Assembly: Output Assembly (197) 
 
 

1 Double-click Data Types under 
Programming – Data in the 
Multiview Explorer. 

 

2 The Data Types Tab Page is 
displayed. 
Click on Structures. The 
Structures Tab Page appears. 
 
Click in the Name field to enter a 
new data type. 
 
In the Name field, enter 
Device_status. 

 
 

 
 

 

3 After confirming the entry, 
right-click in the field and select 
Create New Member from the 
menu. 
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4 Create a data type to check the 
Status Signal details of the Input 
Assembly. 
In Name and Base Type, enter 
the name and data type of each 
signal as shown in the figure on 
the right. 
Assign also the byte offset and 
bit offset values in Offset Byte 
and Offset Bit as shown in the 
figure. 
For a detailed explanation of 
Device_status shown in the 
figure on the right, refer to 
Appendices A-2 EtherNet/IP 
Specifications in the Autofocus 
Multicode Reader MicroHAWK 
V320-F/V330-F/V420-F/V430-F 
Series User Manual for 
Communication Settings (Cat. 
No. Z407). 
 
 
 
 

 

5 Right-click in the tab page and 
select Create New Data Type. 
 
 
 
In the Name field, enter 
S_EIPInput103. 

 
 

 

6 After confirming the entry, 
right-click in the field and select 
Create New Member from the 
menu. 
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7 In Name and Base Type, enter 
the name and data type of each 
signal as shown in the figure on 
the right. 
For a detailed explanation of the 
signals shown in the figure on 
the right, refer to Appendices 
A-2 EtherNet/IP Specifications 
in the Autofocus Multicode 
Reader MicroHAWK 
V320-F/V330-F/V420-F/V430-F 
Series User Manual for 
Communication Settings (Cat. 
No. Z407). 
 
 
 
 

 
 
 

8 As in steps 5 to 7, create new 
data types and members. 
 
Here, we create data types for 
the Output Assembly to control 
the code reader, such as trigger 
input bits. 
 
Assign also the byte offset and 
bit offset values in Offset Byte 
and Offset Bit as shown in the 
figure. 
 
For a detailed explanation of the 
signals shown in the figure on 
the right, refer to Appendices 
A-2 EtherNet/IP Specifications 
in the Autofocus Multicode 
Reader MicroHAWK 
V320-F/V330-F/V420-F/V430-F 
Series User Manual for 
Communication Settings (Cat. 
No. Z407). 
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9 Double-click Programming – 
Data – Global Variables in the 
Multiview Explorer. 

 

10 The Global Variables Tab Page 
is displayed in the Edit Pane. 
 
Click in the Name field to enter a 
new variable. 
 
In the Name field, enter 
EIPOutput. 
 
In the Data Type field, enter 
S_EIPOutput197. 
 
In the Network Publish field, 
select Output from the menu. 

 

   
 

 
 

 
 

 
 

 
 

 
 

11 After confirming the entry, 
right-click in the field and select 
Create New from the menu.  

12 As in steps 2 to 3, enter the 
following data for the newly 
created area. 
• Name: EIPInput 

Data type: S_EIPInput103 
Network Publish: Input 

   



7. EtherNet/IP Connection Procedure 
 

 34 

13 Double-click Configurations 
and Setup – Task Settings in 
the Multiview Explorer. 
The Task Settings Tab Page is 
displayed in the Edit Pane. 
Click on VAR. 

 

14 Click on +. 
 
 
 
The new area is added. 
Click on the down arrow in the 
Variable to be refreshed field 
for the added area (on the left 
side of the tab page). 
 
The variables set in this section 
are displayed. 
Select EIPOutput. 
 
 
 
EIPOutput is added. 
 
* Data Type is automatically set. 

No value needs to be entered. 

  
 

  
 

  
 

  

15 Using the same procedure as in 
step 6, add all the variables set 
in this section to Variable to be 
refreshed (on the left side of the 
tab page). 
 
* Data Type is automatically set. 

No value needs to be entered. 
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7.3.5. Registering the Tags 
Register the tags and tag sets. 
 

1 In the Built-in EtherNet/IP Port 
Settings Connection Settings 
Tab Page, select Tag Set. 
In Tag Sets, select the Input 
Tab Page. 

 

2 Right-click in the Input Tab 
Page and select Create New 
Tag Set from the menu. 

 

3 You can now enter a new tag set 
name. Select the newly added 
Input Area. 
 
Enter EIPInput. 

 
 

 

4 Right-click on EIPInput and 
select Create New Tag from the 
menu. 
 
Under EIPInput, you can now 
enter a new tag name. Select 
the newly added Input Area. 
 
Enter EIPInput to set it as a tag. 
 
* For preset variables, entering 

the first letter displays a list of 
the matching names as shown 
in the figure on the right. 
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5 Select the Output Tab Page. 
Right-click in the Output Tab 
Page and select Create New 
Tag Set from the menu. 

 

6 You can now enter a new tag set 
name. Using the same 
procedure as in step 3, enter 
EIPOutput. 

 

7 Using the same procedures as 
in step 4, add the global variable 
as a tag in order of the OUT No. 
shown in 6.4. Tag Set. 

 

8 Confirm that 2 is shown for both 
Tag Sets and Tags. 
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7.3.6. Setting Up the Connections 
Set the target variables (the side on which connections are to be established) and the 
originator variables (the side on which you want to establish connections) to add connections, 
and then set up the connections (in the tag data link table). 
 

1 In the Built-in EtherNet/IP Port 
Settings Connection Settings 
Tab Page, select Connection. 

 

2 Right-click in Connection and 
select Add from the menu. 

 

3 You can now enter a new 
connection. Select the newly 
added Input Area. 
 
From the Target Device 
pull-down menu, select 
192.168.188.2. 

 
 
 

 

4 A new connection named 
default_001 is created. 
In the Connection I/O Type 
field, select Input 1 Decode. 

 

5 You can now set the Target 
Variable and Originator 
Variable fields.  



7. EtherNet/IP Connection Procedure 
 

 38 

6 Click in the Target Variable field 
for Input. 
 
Press the Ctrl + Space Keys on 
the keyboard to display 
available assembly numbers. 
 
* Entering even the first 

character 1 displays a list of 
matching assembly numbers. 

 
Select the assembly number. 
 
 
In the same way, select the 
Target Variable field for 
Output. 

 
 
 

 
 
 

 
 
 

 

7 Click in Originator Variable 
field for Input. 
A list of available tag set names 
is displayed. Select the one to 
use. 
 
In the same way, set the 
Originator Variable field for 
Output. 

 
 

 

8 Set the Connection Type, 
RPI[ms], and Timeout Value 
fields as needed. 
 

 

9 Confirm that 2 is shown for 
Connections.  
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7.3.7. Transferring the Project Data 
Place the Sysmac Studio online and transfer the connection settings and project data to the 
controller. 
 

 
When you transfer a user program, Configurations and Setup data, device 
variables, or memory values for CJ Units from the Sysmac Studio, the devices 
and machines may operate unexpectedly regardless of the operating mode of 
the CPU Unit. 
Before transferring the project data, check the safety of the destination slaves. 

 

 

1 Turn ON the power supply to the 
controller, switching hub, and 
code reader. 

 

2 Select Check All Programs 
from the Project Menu. 

 

3 The Build Tab Page is 
displayed. 
Confirm that 0 is shown for both 
Errors and Warnings. 

 

4 Select Rebuild Controller from 
the Project Menu. 

 

5 A confirmation dialog box 
appears. Confirm the 
information and click the Yes 
Button. 

 

6 In the Build Tab Page, confirm 
that 0 is shown for both Errors 
and Warnings. 
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7 Select Communications Setup 
from the Controller Menu. 

 

8 The Communications Setup 
Dialog Box is displayed. 
Make sure that the Direct 
connection via USB Option is 
selected in Connection type. 
Click OK. 

 

9 Select Online from the 
Controller Menu. 
A confirmation dialog box 
appears. Confirm the 
information and click Yes. 
 
* The dialog box displayed 

differs depending on the status 
of the controller being used. 
Read the information and 
select Yes or No to proceed 
with the operation. 

 
 

 

10 When you are online, a yellow 
frame appears in the upper part 
of the Edit Pane. 

 

 

 Note 
Refer to Section 6 Online Connections to a Controller in the Sysmac Studio Version 1 
Operation Manual (Cat. No. W504) for details on online connection to the controller. 
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11 Select Synchronization from 
the Controller Menu. 

 

12 The Synchronization Dialog 
Box is displayed. 
Confirm that the data to transfer 
is selected. (In the figure on the 
right, the check box for NJ301 is 
selected.) 
Clear the check box for Do not 
transfer the EtherNet/IP 
connection settings (i.e., tag 
data link settings). 
Click the Transfer to Controller 
Button. 
 
* Executing Transfer to 

Controller transfers the data 
from the Sysmac Studio to the 
controller for data comparison. 

 

13 A confirmation dialog box 
appears. Confirm that there is 
no problem and click the Yes 
Button. 
 
The Synchronizing Dialog Box 
appears. 
 
 
Another confirmation dialog box 
appears. Confirm that there is 
no problem and click the No 
Button. 
 
* Do not return to Run Mode yet. 
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14 Confirm that the synchronized 
data is now shown in the color of 
Synchronized and The 
Synchronization process 
successfully finished 
message is displayed. 
If there is no problem, click 
Close. 
 
* The Synchronization 

process successfully 
finished message indicates 
that the data in the controller 
matches the project data in the 
Sysmac Studio. 

 
* If Synchronization fails, check 

the physical connections and 
redo the procedure from step 
1. 

 

15 In Controller Status, confirm 
that the ERR/ALM indicator is lit 
green and that the mode is 
PROGRAM Mode. 

 

 

 Precautions for Correct Use 

If you change connection settings (in the tag data link table) after executing Synchronize, 
you will not be able to transfer the connection settings (in the tag data link table) by executing 
Synchronize again. 
 
To transfer the 
connection settings in this 
case, click Transfer to 
Controller in the Built-in 
EtherNet/IP Port 
Settings Connection 
Settings Tab Page as 
shown in the right figure. 
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7.4. Checking the EtherNet/IP Communications 
Check that the EtherNet/IP tag data links are operating normally. 
 

7.4.1. Checking the Connection Status 
Check the EtherNet/IP connection status and connect the code reader to the WebLink. 
 

1 Check the LED indicators on the 
controller to confirm that the tag 
data links are operating normally. 
 
Below is the LED status in normal 
operation. 

NET RUN: Lit Green 
NET ERR: OFF 
LINK/ACT: Blinking Yellow 
(Blinking while sending and 
receiving packets) 

 
 

 

2 Check the LED indicators on the 
code reader. 
Below is the LED status for V330 in 
normal operation. 

POWER: Lit Green 
 
Below are the LED status for V430 
in normal operation. 

PASS: OFF 
TRIG: OFF 
MODE: OFF 
LINK: Lit Orange 
FAIL: OFF 
PWR: Lit Green 

For V430 

 

 

3 Select EtherNet/IP Connection 
Settings from the Tools Menu to 
display the EtherNet/IP Device List 
Tab Page.  

4 Right-click Built-in EtherNet/IP 
Port Settings and select Monitor 
from the menu. 

 

5 The Built-in EtherNet/IP Port 
Settings Connection Monitor Tab 
Page is displayed. 
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6 Select the Connection Status Tab 
Page. 
Check that the connection is shown 
with a blue dot ● in the Connection 
Name field. 
Check that 00:0000 is shown in the 
Status field. 

 

 

7 Select the Tag Status Tab Page. 
Check that all tags are listed with a 
blue dot ● in the Tab Name field 
and shown as Normally resolved 
in the Status field. 

 

8 Start your browser and enter 
http://192.168.188.2. 

 

9 The WebLink screen appears. 
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7.4.2. Checking the Sent and Received Data 
Check that the correct data is sent and received. 
To do so, place a readable code symbol in the code reader’s field of view in advance. 
 

 
If you change variable values online in the Watch Tab Page, the devices 
connected to Output Units may operate regardless of the operating mode of the 
CPU Unit. 
Sufficiently confirm safety before you change the values of variables on a 
Watch Tab Page when the Sysmac Studio is online with the CPU Unit. 

 

 

1 This document uses the 2D code 
shown in the right figure as an 
example of reading. 
Set the code reader to the position 
where it can read the 2D code in the 
right figure. 

 

2 Select Watch Tab Page from the 
View Menu. 

 

3 Select Watch Tab Page 1. 

 

4 Click on Input Name and enter the 
Name of the variable to monitor. 
To set a new variable name, enter 
the following variable name. 

EIPOutput.COMMANDS.Trigger 
EIPInput 
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5 For 
EIPOutput.COMMANDS.Trigger, 
change the value in the Modify field 
to TRUE. 
* It is required that 

EIPOutput.COMMANDS.Online is 
TRUE. 

 
Press the Enter Key and confirm 
that Online value for 
EIPOutput.COMMANDS.Trigger is 
True. 

  
 

  

6 The Read processing completes 
and the result is reflected on the 
WebLink screen. 

 

7 EIPInput.DECODE_LENGTH 
and EIPInput.DECODE_DATA 
will display the following for this 
example string. 
 
<Decoded String: 123456> 
EIPInput.DECODE_LENGTH: 6 
EIPInput.DECODE_DATA[0]: 31(1) 
EIPInput.DECODE_DATA[1]: 32(2) 
EIPInput.DECODE_DATA[2]: 33(3) 
EIPInput.DECODE_DATA[3]: 34(4) 
EIPInput.DECODE_DATA[4]: 35(5) 
EIPInput.DECODE_DATA[5]: 36(6) 
 
DECODE_DATA should be set to 
output in ASCII. 
 

 

8 Change the display format to ASCII 
and check DECODE_DATA. 
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8. Initializing the System 
 
In this document, it is assumed that the controller and the code reader uses the factory default 
settings. 
If you change their settings from the default, you may not be able to perform various setting 
procedures as described. 
 

8.1. Initializing the Controller 
To initialize the controller, initialize the CPU Unit. 
Before initialization, place the controller in PROGRAM Mode, and select Clear All Memory 
from Controller Menu in the Sysmac Studio. When the Clear All Memory Dialog Box is 
displayed, confirm the contents and click OK. 

 
 
 

8.2. Initializing the Code Reader 
For information on initializing the code reader, please refer to How to initialize the settings? in 
Q&A in Appendices of the MicroHAWK V320-F/V330-F/V420-F/V430-F Series Barcode 
Reader User Manual (Cat. No. Z432). 
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9. Appendices How to Use the Project File 
 
This section explains the procedure for using the following project file. The project file contains 
the settings described in 7.3. Controller Setup. 
Obtain the latest version of the project file from OMRON Corporation. 
 

Name Filename Version 
Sysmac Studio Compact 
Project File (Extension: 
csm2) 

OMRON_V330_NJ_EIP_V100.csm2 Ver. 1.00 

Sysmac Studio Compact 
Project File (Extension: 
csm2) 

OMRON_V430_NJ_EIP_V101.csm2 Ver. 1.00 

 
 

9.1. Operation Flow 
The procedures for setting up the EtherNet/IP tag data links using the project file are as 
follows. 
Refer to the respective sections, except for 9.2.1. Loading the Project File shown in the red 
frame. 
 

7.2. Code Reader Setup  Set up the code reader. 
   

9.2. Controller Setup  Set up the controller using the project file. 
▼   

 7.3.1. Setting the IP Address  Start the Sysmac Studio and set the IP address of the 
controller. 

▼   
 9.2.1. Loading the Project File  Load the project file in the Sysmac Studio. 

▼   
 7.3.7. Transferring the Project 

Data 
 Place the Sysmac Studio online and transfer the 

connection settings and project data to the controller. 
   

7.4. Checking the EtherNet/IP 
Communications 

 Check that the EtherNet/IP tag data links are 
operating normally. 
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9.2. Controller Setup 
Set up the controller using the project file. 
 

9.2.1. Loading the Project File 
Load the project file in the Sysmac Studio. 
 

1 Select Import from the File 
Menu. 

 

2 The Import file Dialog Box is 
displayed. Select the project file 
OMRON_V330_NJ_EIP_V100.
csm2 or 
OMRON_V430_NJ_EIP_V101.
csm2 and click Open. 
 
* Obtain the latest version of the 

project file from the OMRON 
website. 

 

3 The New Project Dialog Box is 
displayed. Confirm the 
information and click No. 

 

4 The Project Screen is displayed. 
 
* If the error message Cannot 

compare the repositories, the 
version on the target different 
from the source. is displayed, 
change the Sysmac Studio 
version to the version indicated 
in 5.2. Device Configuration or 
higher. 
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5 Select Change Device from the 
Controller Menu. 

 

6 The Change Device Dialog Box 
is displayed. 
Confirm that the Device and 
Version settings for the device 
are as shown in the figure on the 
right. 
 
Click Cancel. 
 
* If using a different device, 

select the device and version 
from the pull-down menus and 
click OK. 
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